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 Sound Systems 

 
Application of Computers 

 Homes 
  Business 
  Educational institutions 
  Research organizations 
  Medical field 
 Government offices 
  Entertainment 



Page No: 4 

Computer Applications in Economics  

Dr. P. Sujatha, Assistant Professor, Department of Economics, ADM College for Women.  

INTRODUCTION TO COMPUTERS 

Meaning of Computer  

What is a Computer? 

A computer is an electronic device that accepts data from the user, Processes it, 

produces results, displays them to the users, and stores the results for future usage. Data is a 

collection of unorganized facts & figures and does not provide any further information regarding 

patterns, context, etc. Hence data means "unstructured facts and figures". 

 

Information is a structured data i.e. organized meaningful and processed data. To 

process the data and convert into information, a computer is used. 

 
Computers are an integral part of our lives. They are used for the reservation of 

Tickets for airplanes and railways, payment of telephone and electricity bills, deposit and 

Withdrawal of money from banks, processing of business data, forecasting of weather 

conditions, diagnosis of diseases, searching for information on the Internet, etc. Computers 

are also used extensively in schools, universities, organizations, music industry, movie 

industry, scientific research, law firms, fashion industry, etc. 

 
The term computer is derived from the word compute. The word compute means to 

calculate. A computer is an electronic machine that accepts data from the user, processes 

the data by performing calculations and operations on it, and generates the desired output 

results. Computer performs both simple and complex operations, with speed and accuracy. 

 

Functions of Computers  

Receiving Input 

Data is fed into computer through various input devices like keyboard, mouse, digital 

pens, etc. Input can also be fed through devices like CD-ROM, pen drive, scanner, etc. 

Processing the information 

Operations on the input data are carried out based on the instructions provided in 

the programs. 

Storing the information 

After processing, the information gets stored in the primary or secondary storage 

area. 
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Producing output 

The processed information and other details are communicated to the outside world 

through output devices like monitor, printer, etc. 

 
Components of Computer System 

Computer systems consist of three components as shown in below image: Central 

Processing Unit, Input devices and Output devices. Input devices provide data input to 

processor, which processes data and generates useful information that’s displayed to the 

user through output devices. This is stored in computer’s memory. 

 
Arithmetic Logic Unit (ALU) 

Data entered into computer is sent to RAM, from where it is then sent to ALU, 

where rest of data processing takes place. All types of processing, such as comparisons, 

decision-making and processing of non-numeric information takes place here and once 

again data is moved to RAM. 

 
Control Unit 

As name indicates, this part of CPU extracts instructions, performs execution, 

maintains and directs operations of entire system. 

 
Functions of Control Unit 

Control unit performs following functions: 

 It controls all activities of computer 

 Supervises flow of data within CPU 

 Directs flow of data within CPU 

 Transfers data to Arithmetic and Logic Unit 

 Transfers results to memory 

 Fetches results from memory to output devices 
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1 Byte = 8 Bits 

Memory Unit 

This is unit in which data and instructions given to computer as well as results 

given by computer is stored. Unit of memory is “Byte”. 
 

 
Characteristics of Computer 
 
Speed 
  
 A computer works with much higher speed and accuracy compared to humans while 

performing mathematical calculations. Computers can process millions (1,000,000) of 

instructions per second. The time taken by computers for their operations is microseconds 

and nanoseconds. For example, a micro computer can execute millions of instructions per 

second. The Super computer executes the instructions thousands or even million times faster 

than that of the micro computers. 

Accuracy 

 Computers perform calculations with 100% accuracy. Errors may occur due to data 

inconsistency or inaccuracy. The very common fact with the human being is “To err is the 

human being”. But this fact is not applied to the computing machine. The computers can do 

errors but these errors can be easily detected and corrected. The degree of accuracy for a 

computer system depends on the design and architecture of that machine. All the operations 

are to be operated by a computer with same accuracy. 

Diligence 

A computer can perform millions of tasks or calculations with the same consistency and 

accuracy. It doesn’t feel any fatigue or lack of concentration. Its memory also makes it 

superior to that of human beings. 

Versatility 

 Versatility refers to the capability of a computer to perform different kinds of works 

with same accuracy and efficiency .The most wonderful feature of the computer system is 

that it can perform various activities of different types from simple calculation to the complex 

scientific operations and computations and is also capable of preparing the examination mark 

sheets, bills, letters, documents and also the design and modeling of navigation missiles and 

satellites. In brief, the computer is capable of performing any task by reducing the task into a 

series of logical steps. They can also communicate with each other to send and receive the 

data. 
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Reliability 

 A computer is reliable as it gives consistent result for similar set of data i.e., if we give 

same set of input any number of times, we will get the same result. 

Automation 

 Computer performs all the tasks automatically i.e. it performs tasks without manual 

intervention. Computers can be easily programmed to perform a series of tasks according to 

the requirements. The computer automatically executes these instructions sequentially. If any 

error occurs, it produces the appropriate error message. 

Memory 

 A computer has built-in memory called primary memory where it stores data. Secondary 

storage are removable devices such as CDs, pen drives, etc., which are also used to store data. 

Storage Capability 

 Large volumes of data and information can be stored in the computer and also retrieved 

whenever required. A limited amount of data can be stored, temporarily, in the primary 

memory. Secondary storage devices like floppy disk and compact disk can store a large 

amount of data permanently. 

 
The Input-Process-Output Concept 

A computer is an electronic device that (1) accepts data, (2) processes data, (3) 

generates output, and (4) stores data. The concept of generating output information from 

the input 4 data is also referred to as input-process-output concept. 

 
The input-process-output concept of the computer is explained as follows: 

 
 

Input The computer accepts input data from the user via an input device like keyboard. The 

input data can be characters, word, text, sound, images, document, etc. 

 

Process The computer processes the input data. For this, it performs some actions on the 

data by using the instructions or program given by the user of the data. The action could 

be an arithmetic or logic calculation, editing, modifying a document, etc. During 

processing, the data, instructions and the output are stored temporarily in the computer’s 

main memory. 
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Output The output is the result generated after the processing of data. The output may be 

in the form of text, sound, image, document, etc. The computer may display the output on 

a monitor, send output to the printer for printing, play the output, etc. 

 

Storage The input data, instructions and output are stored permanently in the secondary 

storage devices like disk or tape. The stored data can be retrieved later, whenever needed. 

 
Types of computer 

The digital computers that are available nowadays vary in their sizes and types.  

The computers are broadly classified into four categories based on their size and type: (1) 

Microcomputers, (2) Minicomputers, (3) Mainframe computers, and (4) Supercomputer. 

 
Types of Computers 

 

 
 

Classification of computers  

Microcomputers 

Microcomputers are small, low-cost and single-user digital computer. They consist 

of CPU, input unit, output unit, storage unit and the software. Although microcomputers 

are stand-alone machines, they can be connected together to create a network of computers 

that can serve more than one user. IBM PC based on Pentium microprocessor and Apple 

Macintosh is some examples of microcomputers. Microcomputers include desktop 

computers, notebook computers or laptop, tablet computer, handheld computer, smart 

phones and netbook, 
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Desktop Computer or Personal Computer (PC) is the most common type of 

microcomputer. It is a stand-alone machine that can be placed on the desk. Externally, it 

consists of three units—keyboard, monitor, and a system unit containing the CPU, 

memory, hard disk drive, etc. It is not very expensive and is suited to the needs of a single 

user at home, small business units, and organizations. Apple, Microsoft, HP, Dell and 

Lenovo are some of the PC manufacturers. 

 
Notebook Computers or Laptop resembles a notebook. They are portable and have 

all the features of a desktop computer. The advantage of the laptop is that it is small in size 

(can be put inside a briefcase), can be carried anywhere, has a battery backup and has all 

the functionality of the desktop. 

 
Netbook These are smaller notebooks optimized for low weight and low cost, and 

are designed for accessing web-based applications. Starting with the earliest netbook in 

late 2007, they have gained significant popularity now. Netbooks deliver the performance 

needed to enjoy popular activities like streaming videos or music, emailing, Web surfing or 

instant messaging.  

 
Tablet Computer has features of the notebook computer but it can accept input from 

a Stylus or a pen instead of the keyboard or mouse. It is a portable computer. Tablet 

Computers are the new kind of PCs. 

 
Handheld Computer or Personal Digital Assistant (PDA) is a small computer that 

can be held on the top of the palm. It is small in size. Instead of the keyboard, PDA uses a 

pen or a stylus for input. PDAs do not have a disk drive. They have a limited memory and 

are less powerful. PDAs can be connected to the Internet via a wireless connection. Casio 

and Apple are some of the manufacturers of PDA.  

 

Smart Phones are cellular phones that function both as a phone and as a small PC. 

They may use a stylus or a pen, or may have a small keyboard. They can be connected to 

the Internet wirelessly. They are used to access the electronic-mail, download music, play 

games, etc. Blackberry, Apple, HTC, Nokia and LG are some of the manufacturers of 

smart phones. 
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Minicomputers 

Minicomputers are digital computers, generally used in multi-user systems. They 

have high processing speed and high storage capacity than the microcomputers. 

Minicomputers can support 4–200 users simultaneously. The users can access the 

minicomputer through their PCs or terminal. They are used for real-time applications in 

industries, research centers, etc. PDP 11, IBM (8000 series) are some of the widely used 

minicomputers.  

 
Mainframe 

Mainframe computers are multi-user, multi-programming and high performance 

computers. They operate at a very high speed, have very large storage capacity and can 

handle the workload of many users. 

Mainframe computers are large and powerful systems generally used in centralized 

databases. The user accesses the mainframe computer via a terminal that may be a dumb 

terminal, an intelligent terminal or a PC. A dumb terminal cannot store data or do 

processing of its own. It has the input and output device only. An intelligent terminal has 

the input and output device, can do processing, but, cannot store data of its own. The dumb 

and the intelligent terminal use the processing power and the storage facility of the 

mainframe computer. Mainframe computers are used in organizations like banks or 

companies, where many people require frequent access to the same data. Some examples 

of mainframes are CDC 6600 and IBM ES000 series. 

 
Supercomputers 

Supercomputers are the fastest and the most expensive machines. They have high 

processing speed compared to other computers. The speed of a supercomputer is generally 

measured in FLOPS (Floating point Operations per Second). Some of the faster 

supercomputers can perform trillions of calculations per second. Supercomputers are built 

by interconnecting thousands of processors that can work in parallel. 

 
Supercomputers are used for highly calculation-intensive tasks, such as, weather 

forecasting, climate research (global warming), molecular research, biological research, 

nuclear research and aircraft design. They are also used in major universities, military 

agencies and scientific research laboratories. Some examples of supercomputers are IBM 

Roadrunner, IBM Blue gene and Intel ASCI red.  
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Computer Hardware  

Hardware 

The term hardware refers to mechanical device that makes up computer. Computer 

hardware consists of interconnected electronic devices that we can use to control 

computer’s operation, input and output. Examples of hardware are CPU, keyboard, mouse, 

hard disk, etc 
 

 
Hardware Components 

Computer hardware is a collection of several components working together. Some 

parts are essential and others are added advantages. Computer hardware is made up of 

CPU and peripherals as shown in image below. 

 

 

 
Hardware Components of Computer 

We have studied about functioning of computer system. Every basic function of the 

Computer system is performed by a specific hardware part. Various hardware parts 

performing some operation are collectively called UNIT. In this way, the hardware 

components of the computer system consists of 3 basic units as : Input Unit, Processing 

Unit, and Output Unit. 
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Input Unit 

The first requirement to solve any computing problem is to receive the input data. 

So first we need to provide input of the data into the computers. The data is to be further 

processed as required. So the instructions for processing the data are also needed to put 

into the computer system. Special electronic and mechanical devices are used for these 

purposes. These devices are collectively known as Input Unit. The common functions of 

all input devices include the receiving of data and instructions from user, convert it to 

computer understandable form and supply to other units for further processing. Common 

input devices are Keyboard, Mouse, Joystick, Light Pen, Track Ball, etc. 

 
Processing Unit 

It is the part of computer system, where actual computing operations take place. 

The input data is used by such computations and then the result is sent to the output unit. 

So, it is the main part of computer system which operates on the program instructions and 

called as Central Processing Unit (CPU). It works like the brain of computer system which 

handles all the computing operations. CPU consists of 3 parts as: The Memory Unit, 

Control Unit, and the Arithmetic & Logical Unit. 

 
(i) Memory Unit (MU) 

The memory unit is considered as the part of CPU, But some scientists keep it as 

the separate unit of computer system having inter-relation to the control unit. The memory 

unit lies among input unit, output unit and control unit. The input data is firstly stored in 

the memory. The data to be produced as output is also stored in memory. The intermediate 

results of calculations are also stored in the memory. So, the memory unit of the computer 

system is called as primary memory or main memory 

 
(ii) Control Unit (CU) 

As the name indicates, this unit controls all other units of the computer system. It 

instructs the input unit to receive the data and also to store the data. Similarly, it controls 

the data flow from memory to ALU and vice-versa. It also controls the data flow to output 

unit. In all, we can say that the Control Unit works as the Nervous System for the entire 

computer system. 
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(iii) Arithmetic and Logical Unit (ALU) 

It is the unit of computer system, responsible for all calculation works, arithmetic as 

well as logical. The control unit supplies the calculative data to ALU, so that ALU can 

perform the arithmetic operations (addition, subtraction, multiplication, division, etc.) and 

also logical operations (comparisons and decision making). After performing the 

calculations, the result is again stored to the memory unit by control unit. 

 
Computer Software 

A set of instructions that drives computer to do stipulate tasks is called a program. 

Software instructions are programmed in a computer language, translated into machine 

language, and executed by computer. Software can be categorized into two types: 

 
System Software 

System software operates directly on hardware devices of computer. It provides a 

platform to run an application. It provides and supports user functionality. Examples of 

system software include operating systems such as Windows, Linux, UNIX, etc. 

 
Application Software 

Application software is designed for benefit of users to perform one or more tasks. 

Examples of application software include Microsoft Word, Excel, PowerPoint, Oracle, etc. 

 
Differences between software and hardware 

 

S. No Software Hardware 

1 It is a collection of programs to bring 

computer hardware system into

operation. 

It includes physical components of 

computer system. 

2 It includes numbers,  alphabets, 

alphanumeric symbols, identifiers,

keywords, etc. 

It consists of electronic components like 

ICs, diodes, registers, crystals, boards, 

insulators, etc. 

3 Software products evolve by adding 

new features to existing programs to 

support hardware. 

Hardware design is based on architectural 

decisions to make it work over a range of 

environmental conditions and time. 



Page No: 14 

Computer Applications in Economics  

Dr. P. Sujatha, Assistant Professor, Department of Economics, ADM College for Women.  

 

4 It will vary as per computer and its 

built-in functions   and programming 

language. 

It is mostly constructed for all types of 

computer systems. 

5 It is designed and developed by 

experienced programmers in high- level

language. 

The hardware can understand only low- 

level language or machine language. 

6 It is represented in any high-level 

language such as BASIC, COBOL, C, 

C++, JAVA, etc. 

The hardware works only on binary codes 1’s 

and 0’s. 

 
 

 
 

 
7. The software is categorized as

operating system, utilities, language 

processor, application software, etc. 

The hardware consists of input devices, 

output devices, memory, etc. 

 
 

Generations of Computers 

First Generation (1940 to 1956): Using Vacuum Tubes 

 First generation computers were vacuum tubes-based machines. These were large  in 

size, expensive to operate and instructions were written in machine language. Their 

computation time was in milliseconds. 

Second Generation (1956 to 1963): Using Transistors 

 Second generation computers were transistor-based machines. They used the stored 

program concept. Programs were written in assembly language. They were smaller in size, 

less expensive and required less maintenance than the first-generation computers. The 

computation time was in microseconds. 
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Third Generation (1964 to 1971): Using Integrated Circuits 

Third generation computers were characterized by the use of IC. They consumed less 

power and required low maintenance compared to their predecessors. High-level languages 

were used for programming. The computation time was in nanoseconds. These computers 

were produced commercially. 

Fourth Generation (1971 to present): Using Microprocessors 

Fourth generation computers used microprocessors which were designed using the 

LSI and VLSI technology. The computers became small, portable, reliable and cheap. The 

computation time is in picoseconds. They became available both to the home user and for 

commercial use. 

Fifth Generation (Present and Next): Using Artificial Intelligence 

Fifth generation computers are capable of learning and self-organization. These 

Computers use SLSI chips and have large memory requirements. They use parallel 

processing and are based on AI. The fifth-generation computers are still being developed. 

 
Input Devices 

 Input devices - parts of the computer that allow information or data to be given to 

the computer like keyboard or a mouse. 

An input device is a piece of equipment used to provide data and control signals to 

an information processing system such as a computer or information appliance. Examples 

of input devices include keyboards, mouse, scanners, digital cameras, joysticks, and 

microphones. 

 Keyboard and Mouse 

 Trackballs 

 Digital Pens 

 Scanners 

 Barcode readers 

 Voice Recognition System 

 Touch screen 
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Input devices and their characteristics 
 

 
Input Devices Characteristics Image 

 
 

Trackballs 

A trackball is also a pointing device 

which will work like a mouse. It is 

mainly used for gaming and 

entertainment purpose 

 
 

 

 
 

Digital Pens 

A digital pen is another  input 

device which is mostly used with 

tablets, PDAs, etc. 

A digital pen is also called as a 

Stylus which helps to write or draw 

data over pad. 

 

 
 

Scanners 

Scanners transform printed material 

and photographs into a digital 

representation. 

After scanning of printed material, 

page is represented in memory as an 

array of pixels. 

 
 

 

 
 

Barcode readers 

Barcode reader helps to read 

information which is printed as bars 

in back of goods or items. 

Barcode readers are most widely 

used input devices which we can 

see in most of products in  our day 

to day life. 
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Voice Recognition 

System 

Voice recognition system interprets 

or receives dictation or spoken 

commands to authorize user. 

 
 

 

 
Touch screen 

 
A touch screen is an input device 

which uses sensors to sense touch 

of users to get input data. 

 
 

 

 

Output Devices 

Output devices - parts of the computer that gives out information generated by the 

computer, like a monitor, printer or speaker. 

An output device is any piece of computer hardware equipment which converts 

information into human-readable form. It can be text, graphics, tactile, audio, and video. 

Some of the output devices are Visual Display Units (VDU) i.e. a Monitor, Printer, 

Graphic Output devices, Plotters, Speakers etc 

 Monitor 

 Printers 

 Sound Systems 

Output devices and their characteristics 
 

Output Devices Characteristics Image 

 
Monitor 

A monitor is most common type of output 

device. 

It is also called as “Visual Display Unit”. 

The inputs given by keyboard or any other 

input devices will get displayed on 

monitor. 

Cathode Ray Tube (CRT) and Flat panel 

display monitors   are commonly used 

monitors. 
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Printers 

Printers are most common type of output 

devices which are used to take a hard copy 

of any digital document. 

The two types of printers are impact and 

non-impact printers. 

Non-impact printers such as laser and 

inkjet printers are less noisy, more 

 
 

 

 

Applications of Computers 

Computer plays a role in every field of life. They are used in 

Home 

Computers are used at homes for several purposes like online bill payment, 

watching movies or shows at home, home tutoring, social media access, playing games, 

internet access, etc. They provide communication through electronic mail. They help to 

avail work from home facility for corporate employees. Computers help the student 

community to avail online educational support. 

Microprocessors are embedded in house hold utilities like, washing machines, TVs, 

food processors, home theatres, security devices, etc. 

The list of applications of computers is so long that it is not possible to discuss all of 

them here. Computers have also proliferated into areas like banks, investments, stock 

trading, accounting, ticket reservation, military operations, meteorological predictions, 

social networking, business organizations, police department, video conferencing, tele 

presence, book publishing, web newspapers, and information sharing. 

 
Medical Field 

Computers are used in hospitals to maintain a database of patients’ history, 

diagnosis, X- rays, live monitoring of patients, etc. Surgeons nowadays use robotic surgical 

devices to perform delicate operations, and conduct surgeries remotely. Virtual reality 

technologies are also used for training purposes. It also helps to monitor the  fetus inside 

the mother’s womb. 
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Medical researchers and practitioners use computers to access information about 

the advances in medical research or to take opinion of doctors globally. The medical 

history of patients is stored in the computers. Computers are also an integral part  of 

various kinds of sophisticated medical equipment like ultrasound machine, CAT scan 

machine, MRI scan machine, etc. Computers also provide assistance to the medical 

surgeons during critical surgery operations like laparoscopic operations, etc. 

 

Entertainment 

Computers help to watch movies online, play games online; act as a virtual 

entertainer in playing games, listening to music, etc. MIDI instruments greatly help 

people in the entertainment industry in recording music with artificial instruments. 

Videos can be fed from computers to full screen televisions. Photo editors are available 

with fabulous features. 

Computers have had a major impact on the entertainment industry. The user can 

download and view movies, play games, chat, book tickets for cinema halls, use 

multimedia for making movies, incorporate visual and sound effects using computers, 

etc. The users can also listen to music, download and share music, create music using 

computers, etc. 

 

Industry 

Computers are used to perform several tasks in industries like managing 

inventory, designing purpose, creating virtual sample products, interior designing, video 

conferencing, etc. Online marketing has seen a great revolution in its ability to sell 

various products to inaccessible corners like interior or rural areas. Stock markets have 

seen phenomenal participation from different levels of people through the use of 

computers. 

 

Education 

Computers are used in education sector through online classes, online 

examinations, referring e-books, online tutoring, etc. They help in increased use of 

audio- visual aids in the education field. 
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Computers are extensively used, as a tool and as an aid, for imparting education. 

Educators use computers to prepare notes and presentations of their lectures. Computers 

are used to develop computer-based training packages, to provide distance education 

using the e-learning software, and to conduct online examinations. Researchers use 

computers to get easy access to conference and journal details and to get global access to 

the research material. 

Government 

In government sectors, computers are used in data processing, maintaining a 

database of citizens and supporting a paperless environment. The country’s defense 

organizations have greatly benefitted from computers in their use for missile 

development, satellites, rocket launches, etc. 

The government uses computers to manage its own operations and also for e- 

governance. The websites of the different government departments provide information 

to the users. Computers are used for the filing of income tax return, paying taxes, online 

submission of water and electricity bills, for the access of land record details, etc. The 

police department uses computers to search for criminals using fingerprint matching, etc. 

Banking 

In the banking sector, computers are used to store details of customers and 

conduct transactions, such as withdrawal and deposit of money through ATMs. Banks 

have reduced manual errors and expenses to a great extent through extensive use of 

computers. 

Business 

Nowadays, computers are totally integrated into business. The main objective of 

business is transaction processing, which involves transactions with suppliers, 

employees or customers. Computers can make these transactions easy and accurate. 

People can analyze investments, sales, expenses, markets and other aspects of business 

using computers. 

Training 

Many organizations use computer-based training to train their employees, to save 

money and improve performance. Video conferencing through computers allows saving 

of time and travelling costs by being able to connect people in various locations. 

Arts 

Computers are extensively used in dance, photography, arts and culture. The fluid 
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movement of dance can be shown live via animation. Photos can be digitized using 

computers. 

Science and Engineering 

Computers with high performance are used to stimulate dynamic process in 

Science and Engineering. Supercomputers have numerous applications in area of 

Research and Development (R&D). Topographic images can be created through 

computers. Scientists use computers to plot and analyze data to have a better 

understanding of earthquakes. 

Computers have proliferated into various areas of our lives. For a user, computer 

is a tool that provides the desired information, whenever needed. You may use computer 

to get information about the reservation of tickets (railways, airplanes and cinema halls), 

books in a library, medical history of a person, a place in a map, or the dictionary 

meaning of a word. The information may be presented to you in the form of text, 

images, video clips, etc. 

Scientists and engineers use computers for performing complex scientific 

calculations, for designing and making drawings (CAD/CAM applications) and also for 

simulating and testing the designs. Computers are used for storing the complex data, 

performing complex calculations and for visualizing 3– dimensional objects. Complex 

scientific applications like the launch of the rockets, space exploration, etc., are not 

possible without the computers. 

Sports 

A computer can be used to watch a game, view the scores, improve the game, play 

games (like chess, etc.) and create games. They are also used for the purposes of training 

players. 

Advertising 

Computer is a powerful advertising media. Advertisement can be displayed on 

different websites, electronic-mails can be sent and reviews of a product by different 

customers can be posted. Computers are also used to create an advertisement using the 

visual and the sound effects. For the advertisers, computer is a medium via which the 

advertisements can be viewed globally. Web advertising has become a significant factor 

in the marketing plans of almost all companies. In fact, the business model of Google is 

mainly dependent on web advertising for generating revenues.  
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UNIT -2  
 

 MS-Word Features  
 Starting Word  
 Entering Text  
 Saving, Opening a document  
 Editing and Formatting a Document 
 Mail Merge 
 MS Access 

 

Introduction 
 Word processing is using a computer program to create, edit, and produce text 

documents. Word processing programs help you create professional quality 

documents because they let you type and format text, correct errors, and preview 

your work before you print or distribute a document. 

  

MS-Word Features  
 

1. Type a document through the keyboard and save it disk. 

2. Correct, delete and insert characters, words, lines anywhere in the document. 

3. Retrieve documents from the disk and when required. 

4. Move or copy paragraph, etc. from one place to another place in the same  documents 

 or any other document. 

5. Decrease or increase the left, right, top or bottom margins of document according to 

 the requirement. 

6. Change the text font and style or you can say display appearance. 

7. Search for a particular work or phrase in the document 

8. Search for errors in document and make corrections to them. 

9. Print a document in required formats on paper 

10. Print the document using mail merge, a special feature of word processing package 

 which allows todo a large work in less time. 
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Starting Word  
 

 On the taskbar, click Start, point to programs, and then click Microsoft Word. The 

word window opens with a blank document and the new document task pane in the document 

window. 

Parts of Word Window 

 
Menu bar  

 When you point to any menu title and click once with the mouse, the menu will open 
displaying all the commands available under this menu. Clicking on the desired command 
would tell Word to execute that command. Some commands have ellipses (…) in front of 
them. These commands have further sub commands.  

 
Standard toolbar  
 Toolbars contain buttons, drop-down menus and other controls that help you to 
quickly alter the appearance and arrangement of documents by executing a variety of word 
commands. The standard toolbar contains icons for basic functions like opening files, saving 
files, printing files, cut, copy, paste etc. 
 
Formatting toolbar  
 This contains icons for changing the look of your text for example, there are icons for 
changing fonts, styles, font sizes, text alignment etc. 
 
Ruler  
 The Ruler lets you make changes to margins and indents, and helps you create 
document as per dimensions required. 
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Scroll tools  
 These helps you travel within your document. You can go anywhere, up and down, 
right and left in your document mainly by two ways: Using the horizontal and vertical scroll 
bars with the help of the mouse; or using the keyboard to press PgUp, PgDown, Home, End 
and arrow keys. 
 
Status bar  
 Also called the Status Area, this is the normally the last line on your screen. This 
gives the following information about your work— 
 

 Current Page 
 Section Number 
 Current/Total pages in the document 
 Current Cursor Position (where the cursor is presently located) 
 Current Line Number 
 Current Column Number 
 Record Macro-whether macro recording is On or not 
 Track Revision-whether revisions have been made or not 
 Extend Selection 
 Over type mode-whether you are in Insert mode or overwrite mode 

 
Cursor  
 Also called the Insertion Pointer, this denotes the place where text, graphics or any 
other item would be placed when you type, overwrite or insert them. This looks like a tall, 
skinny toothpick and keeps blinking so that you can locate it easily. 
 
Mouse pointer  
 When your mouse pointer looks like an I-beam you should be able to move it freely 
on the screen. This is used for either placing the cursor at the desired place (take the mouse 
pointer there and click) or choosing any command either from the menu or from toolbars. 
The mouse pointer changes shape when in the process of doing certain tasks and the cursor 
disappears. 
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TOOLBARS AND THEIR ICONS 
 
Word Standard Toolbar 
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Entering Text  
 
Creating a New Document 
 
Word gives you four ways to create a new document 
 

1. When you first run word, it automatically creates a new document, 
 ready for you to start typing 

2. You can click the New Black Document button on the standard  toolbar. 
3. You can choose File-New 
4. You can press Ctrl + N 

 

 
 
Opening an Existing Document: 
 
 Click File Menu 
 Select and click Open option 

 Otherwise click button on the Standard toolbar. 

 Double click on the file from the open window 

 



Computer Applications in Economics  

Dr. P. Sujatha, Assistant Professor in Economics, ADM College for Women (Autonomous)     Page 28  

o 

Saving a Document 

 Click File Menu 

 Select and click Save button. 

 Otherwise click button       on the Standard toolbar. 

 

 
Moving through the document 
 

 Open any word document. You can move the cursor to any location on the screen by 
using the arrow keys on the keyboard. 

 Right arrow key is used to move one position to the right of the cursor 
 Left arrow key is used to move one position to the left of  the cursor. 
 Up arrow key is used to move one position to the top of the cursor. 
 Down arrow key is used to move one position to the down   of the cursor. 
 Page Up key is used to move down the screen at a time 
 Page down key is used to move up the screen at a time 
 Hold down Ctrl key and press Home to move to beginning of the document. 
 Hold down Ctrl key and press End to move to end of the document. 

 You can move to any position on the screen by moving the cursor with the mouse. 
 You can use scroll bars to scroll the text upward and down ward. 

 
Closing a Document 
 

 Click File menu 
 Select and click Close button. 
 Otherwise click on menu bar 
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Editing a Document 

 
Cut, Copy and Paste options 
 
These options will allow you to Cut or Copy a piece of text from one location and to paste at a 
new location. 
 
To do these functions, 

 Place the cursor at the beginning of the text to be selected. Drag the mouse pointer over 
the text.  

 Click Edit menu and then click on Cut option (or)click icon on the Standard 
Toolbar. Move the cursor to the place where you want the text to be pasted. 
 
 Click Edit menu and then click Paste option (or)click icon on the Standard Toolbar. 
 
 For copying the text from one location to other location the same procedure is to be 
followed.  
 
 The difference between Cut and Copy is that while using the Cut option the text will 
be removed from its original location and pasted at a new location, whereas when using 
Copy option, a copy of the selected text is pasted at new location without disturbing the 
original text. 

 

Searching text 
 

 Open any document. 
 Click Edit menu and then click Find option. You will get a screen as shown below. 

 

 
 

 In Find What text box type the word you want to find and then click Find Next button. 
 Continue clicking Find Next button until you get the screen shown below. 
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 Click OK button and then click X to close Find andReplacedialogbox. 
 
Replacing text 
 

 Open any word document. 
 Click Edit menu and then click Replace option. You will get the dialog box as shown 

below and type the word with which you want to replace. 
 

 
 

 Click Replace All button once. You get the below dialog box. 
 

 
 

 Click OK button and then click to close Find and Replace dialog box. 
 
 

Moving the cursor to a specific page 
 

 If your word document contains more than one page, you can directly go to specified 
page by clicking Edit menu and then clicking Go To option. You will get the dialog box 
as shown below. 
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 In the Enter page number text box, type the required page number as shown above. 

 Click Go To button. Cursor will immediately jump to page4. 
 Click Close button to close Find and Replace dialog box. 

 
Formatting Documents 
 
Bold, Underline and Italicize the selected text 

 Open a word document. 
 Block the text by first clicking at the start of the text and holding the left mouse button 

and drag to the desired position and then release the left mouse button. The selected area 
will be highlighted. 

 Move the mouse pointer to the button on the Standard Toolbar and click once. 
 Move the mouse pointer outside your text and click to release the highlighting. Your 

text will now appear in BOLDFACE. 
 Like this you can underline or italicize the desired text by using the following buttons 

 
Left aligning, centering, right aligning and justifying text 

 
Left Centre Right Justify 

 Open a word document. 
 Block the text by first clicking at the start of the text and holding the left mouse button 

and drag to the desired position and then release the left mouse button. The selected area 
will be highlighted. 

 Move the mouse pointer to Align Left button on the toolbar and click once. Your 
selected text will be left aligned. 

 Move the mouse pointer to Align right button on the toolbar and click once. Your 
selected text will be right aligned. 

 Move the mouse pointer to Center button on the toolbar and click once. Your selected 
text will be centered. 

 Move the mouse pointer to justify button on the toolbar and click once. Your selected 
text will be justified. 
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Creating Bulleted and Numbered list 
 

 If a list of items is to be numbered automatically it can be done using Numbered List 
option 

1. Ex: Microsoft Office consists of MS-Word 
2. MS-Excel 
3. MS-PowerPoint MS-Access 

 
 The above text is to be selected with mouse. 

 Click on the Numbered List button on the toolbar  

 Move out of the text and click to release the highlighting. 
 Your text will now look like this 

 
 MS-Word 
 MS-Excel 
 MS-PowerPoint 
 MS-Access 

 
 Now re-select the text 
 Click the Bulleted List button on the toolbar. 

 The numbers should be replaced with bullets as shown below 
 

 MS-Word 
 MS-Excel 
 MS-PowerPoint 
 MS-Access 

 
 
Creating column wise documents 
 

 Open any word document file. 
 Click Format menu and click Columns option. You will get a screen as shown below: 
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 Click OK button. 
 Your document will be converted to two-column document. 

 
Creating Header and footer 
 You can create header and footer that include text or graphics. For example, page 

numbers, the date, a company logo, the document’s title or file name, the author’s name, and so 

on. You can use the same header and footer throughout a document or change the header and 

footer for part of the document. For example, use a unique header or footer on the first page, or leave 

the header or footer off the first page. You can also use different headers and footers on odd and even 

pages or for part of a document. 
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To create a table using table menu 
 

 Choose Insert table from Table Menu. You will find a dialog box as shown below: 
 

 Now type the Number of Columns and rows as you require and set column width Auto. 

So that the Column with will be equal to the width of the text. Now click OK. 

 An empty table is inserted in the document. Now inserting rows, columns, deleting rows 

and widening the columns is very easy. 

 

Insert Rows 
 

 Place the cursor in the table, where rows are to be inserted 
 Choose Table and click Insert Rows option to insert rows in the table 

 
Delete Rows 

 Select the Row which is to be deleted 
 Click Table and click Delete cells option. 

 

 
 
In the same way you can do with columns also. 

Using Formulae in the table 
 
Tables can be used to prepare financial statements. Different functions can be used to calculate 
Column totals, Row totals, Average, Count, Minimum and maximum of given values etc. 
 
To use a formula in the table 
 

 Keep the mouse cursor at the place where the value has to come 
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 Click Table menu and then click Formula option. 
 
You can see the following dialog box. 

 
 

 Then click OK button 
 
 
 
Mail Merge 
 
Creating a Mail Merge document 
Following are steps involved in creating a Mail Merge document. 
 

 Create a new data source and enter information 
 Create the main document 
 Insert fields into the main document. 
 Merge data source and main document. 

 
Creating a new data source 
 This file is created basically to store the information like addresses which is to be used 
to merge with the main document. 
 

 Open a New word document 
 Create a Table with following information: 

 
First Name Last Name Add1 Add2 Add3 

Sujatha. P Palani aaaaa ddddd ggggggggg 
Mani Rethinam bbbbbbbbbb eeeeeee hhhhhhhhhh 

Dhasu Mani ccccccccccc fffffffff iiiiiiiiiiiiiiiii 

Logu Mani Kkkkkkkkkk Llllll mmmm 

 
Save the file as address.doc and close. 
 
Creating the Main Document 
 

 From the Tools menu Letters and Mailing Mail Merge. 
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 In the Main Document area of Mail Merge Helper window click the Create button. 
Clicking on the down arrow opens the pull-down menu. 

 
 

 Select Letters. and under Step 1 of 6, Click on  
 Next:  Starting document as shown in the above window (step1). 
 You will get 3 options to select from the following window 

 
o Use the Current Document 
o Start from a template. 
o Start from Existing Document 

 
 Select the first option: Use the current document 
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Type the letter leaving sufficient space to place addresses later 
 

 
 

 Now click on Write your letter link (step 3) Then you will get following window. 

 Now Select an Existing Data Source i.e. the file address.doc and Click on Open Button. 
 
 Then you will get following window. 
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Click Ok. 
 

 Then you will see the following screen 
 To add recipient information to your letter Click on More items and insert the fields 

wherever required. 
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 Now see Step 4 of 6 and click on Next: Preview your letters 
 

 
 

 You can preview all the letters by clicking on Recipient 1..2.. soon. 
 After Preview come to Step 5 of 6 and click on Next: Complete merge 
 After completing the merge, you may print letters or edit the musing the 

following options: 
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Microsoft Access 
 
  Microsoft Access is a Database Management System (DBMS) from Microsoft that 
combines the relational Microsoft Jet Database Engine with a graphical user interface and 
software development tools. It is a member of the Microsoft Office suite of applications, 
included in the professional and higher editions. 
 
  Microsoft Access stores information which is called a database. To use MS Access, you will 
need to follow these four steps – 

 

 Database Creation − Create your Microsoft Access database and specify what kind of data you 
will be storing. 

 Data Input − After your database is created, the data of every business day can be entered into 
the Access database.  

 Query − This is a fancy term to basically describe the process of retrieving information from the 
database. 

 Report (optional) − Information from the database is organized in a nice presentation that can be 
printed in an Access Report. 

Advantages of MS ACCESS 

Here, are the pros/benefits for using MS Access application: 

 Access offers a fully functional, relational database management system in minutes. 
 Easy to import data from multiple sources into Access 
 You can easily customize Access according to personal and company needs 
 Access works well with many of the development languages that work on Windows OS 
 It is robust and flexible, and it can perform any challenging office or industrial database 

tasks. 
 MS-Access allows you to link to data in its existing location and use it for viewing, 

updating, querying, and reporting. 
 Allows you to create tables, queries, forms, and reports, and connect with the help of 

Macros 
 Macro in Access is a simple programming construct with which you can use to add 

functionality to your database. 
 It can perform heterogeneous joins between various data sets stored across different 

platforms 

Disadvantages of MS-ACCESS 

Here, are the cons for using MS Access 

 Microsoft Access is useful for small-to-medium business sectors. However, it is not 
useful for large-sized organizations 

 Lacks robustness compared to DBMS systems like MS SQL Server or Oracle 
 All the information from your database is saved into one file. This can slow down 

reports, queries, and forms 
 Technical limit is 255 concurrent users. However, the real-world limit is only 10 to 80 

(depending on the type of application which you are using) 
 It requires a lot more learning and training compares with other Microsoft programs 
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MS 
Access 

Database Creation  
 
 To create a database from a template, we first need to open MS Access and you will see the 
following screen in which different Access database templates are displayed. To view the all the possible 
databases, you can scroll down or you can also use the search box. 
 

 
 
Let us enter project in the search box and press Enter. You will see the database templates related to project 
management. 

 
Select the first template. You will see more information related to this template. 
 
After selecting a template related to your requirements, enter a name in the File name field and 
you can also specify another location for your file if you want. 
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Now, press the Create option. Access will download that database template and open a new 
blank database as shown in the following screenshot. 

 
Now, click the Navigation pane on the left side and you will see all the other objects that  
Come with this database. 

 
 

Click the Projects Navigation and select the Object Type in the menu. You will now see all the 
objects types — tables, queries, etc. 
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Create Blank Database 
Sometimes database requirements can be so specific that using and modifying the 
existing templates requires more work than just creating a database from scratch. 
In such case, we make use of blank database. 

Step 1: Let us now start by opening MS Access. 

 
 

Step 2: Select Blank desktop database. Enter the name and click the Create button. 
 
 
Step 3: Access will create a new blank database and will open up the table which 
is also completely blank. 
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Select the Views > Datasheet View option in the ribbon and add some data as 

shown in the following screenshot. 
 

Similarly, add some data in the second table as well as shown in the following screenshot. 
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UNIT III 

UNIT III MS – EXCEL, POWER POINT AND E-MAIL 

MS Excel Features 

  There are a number of features that are available in Excel to make your task easier. 
Some of the main features are:  

AutoFormat - lets you to choose many preset table formatting options.  

1. AutoSum - helps you to add the contents of a cluster of adjacent cells.  

2. List AutoFill - automatically extends cell formatting when a new item is added to the 
end of a list. 

3. AutoFill - feature allows you to quickly fill cells with repetitive or sequential data such 
as chronological dates or numbers, and repeated text. AutoFill can also be used to copy 
functions. You can also alter text and numbers with this feature.  

4. AutoShapes toolbar will allow you to draw a number of geometrical shapes, arrows, 
flowchart elements, stars and more. With these shapes you can draw your own graphs.  

5. Wizard - guides you to work effectively while you work by displaying various helpful 
tips and techniques based on what you are doing. Drag and Drop - feature will help you 
to reposition the data and text by simply dragging the data with the help of mouse.  

6. Charts - features will help you in presenting a graphical representation of your data in 
the form of Pie, Bar, Line charts and more.  

7. PivotTable - flips and sums data in seconds and allows you to perform data analysis and 
generating reports like periodic financial statements, statistical reports, etc. You can 
also analyse complex data relationships graphically.  

8. Shortcut Menus - commands that are appropriate to the task that you are doing appear 
by clicking the right mouse button.  

 

Simple steps start the excel application following the below  

Step 1 − Click on the Start button. 
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Step 2 − Click on All Programs option from the menu. 

 
 
Step 3 − Search for Microsoft Office from the sub menu and click it. 
Step 4 − Search for Microsoft Excel 2010 from the submenu and click it. 
 

 
 
 
The following basic window appears when you start the excel application. Let us now 

understand the various important parts of this window. 
 
 

 
 

 
 
 

 

File 

Activ

Text 
 

File Type 

Enteri
ng 
Form

New 
text 

Vertical Alignmen
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Ribbon 

 

Ribbon contains commands organized in three components − 

 Tabs − They appear across the top of the Ribbon and contain groups of related 
commands. Homes, Insert, Page Layout are the examples of ribbon tabs. 

 Groups − They organize related commands; each group name appears below the group 
on the Ribbon. For example, group of commands related to fonts or group of 
commands related to alignment etc. 

 Commands − Commands appear within each group. 

Zoom Control 

Zoom control lets you zoom in for a closer look at your text. The zoom control consists 
of a slider that you can slide left or right to zoom in or out. The + buttons can be clicked to 
increase or decrease the zoom factor. 

View Buttons 

The group of three buttons located to the left of the Zoom control, near the bottom of the 
screen, lets you switch among excel's various sheet views. 

 Normal Layout view − This displays the page in normal view. 

 Page Layout view − This displays pages exactly as they will appear when printed. This 
gives a full screen look of the document. 

 Page Break view − This shows a preview of where pages will break when printed. 

Sheet Area 

The area where you enter data. The flashing vertical bar is called the insertion point and it 
represents the location where text will appear when you type. 

Row Bar 

Rows are numbered from 1 onwards and keep on increasing as you keep entering data. 
Maximum limit is 1,048,576 rows. 

Column Bar 

Columns are numbered from A onwards and keeps on increasing as you keep entering data. 
After Z, it will start the series of AA, AB and so on. Maximum limit is 16,384 columns. 

Status Bar 

This displays the current status of the active cell in the worksheet. A cell can be in either of the 
fours states (a) Ready mode which indicates that the worksheet is ready to accept user input 
(b) Edit mode indicates that cell is editing mode, if it is not activated the you can activate 
editing mode by double-clicking on a cell (c) A cell enters into Enter mode when a user types 
data into a cell (d) Point mode triggers when a formula is being entered using a cell reference 
by mouse pointing or the arrow keys on the keyboard. 
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1 Save 
If an existing sheet is opened, it would be saved as is, otherwise it will display a 
dialogue box asking for the sheet name. 

2 Save As 
A dialogue box will be displayed asking for sheet name and sheet type. By default, 
it will save in sheet 2010 format with extension .xlsx. 

3 Open This option is used to open an existing excel sheet. 

4 Close This option is used to close an opened sheet. 

5 Info This option displays the information about the opened sheet. 

6 Recent This option lists down all the recently opened sheets. 

7 New This option is used to open a new sheet. 

8 Print This option is used to print an opened sheet. 

9 Save & Send This option saves an opened sheet and displays options to send the 
sheet using email etc. 

10 Help You can use this option to get the required help about excel 2010. 

11 Options Use this option to set various option related to excel 2010. 

12 Exit Use this option to close the sheet and exit. 

  
  Entering values in excel sheet is a child’s play and this chapter shows how to enter 

values in an excel sheet. A new sheet is displayed by default when you open an excel sheet as 

shown in the below screen shot. 

 
 

Sheet area is the place where you type your text. The flashing vertical bar is called the 

insertion point and it represents the location where text will appear when you type. When you 



Computer Applications in Economics  

Dr. P. Sujatha, Assistant Professor in Economics, ADM College for Women (Autonomous)     Page 50  

click on a box then the box is highlighted. When you double click the box, the flashing vertical 

bar appears and you can start entering your data. 

So, just keep your mouse cursor at the text insertion point and start typing whatever text you 

would like to type. We have typed only two words "Hello Students" as shown above. The text 

appears to the left of the insertion point as you type. 

There are following three important points, which would help you while typing − 

 Press Tab to go to next column. 

 Press Enter to go to next row. 

 Press Alt + Enter to enter a new line in the same column. 

Excel provides a number of ways to move around a sheet using the mouse and the 
keyboard. 

 

 

Moving with Mouse 

 You can easily move the insertion point by clicking in your text anywhere on the 
screen. Sometime if the sheet is big then you cannot see a place where you want to 
move.  

 You can scroll your sheet by rolling your mouse wheel, which is equivalent to clicking 
the up-arrow or down-arrow buttons in the scroll bar. 

Moving with Scroll Bars 

As shown in the above screen capture, there are two scroll bars: one for moving vertically 
within the sheet, and one for moving horizontally. Using the vertical scroll bar, you may − 

 Move upward by one line by clicking the upward-pointing scroll arrow. 

 Move downward by one line by clicking the downward-pointing scroll arrow. 

 Move one next page, using next page button (footnote). 
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 Move one previous page, using previous page button (footnote). 

 Use Browse Object button to move through the sheet, going from one chosen object to 
the next. 

Moving with Keyboard 

The following keyboard commands, used for moving around your sheet, also move the 
insertion point − 

Keystroke Where the Insertion Point Moves 

 
Forward one box 

 

Back one box 

 

Up one box 

 

Down one box 

PageUp To the previous screen 

PageDown To the next screen 

Home To the beginning of the current screen 

End To the end of the current screen 

You can move box by box or sheet by sheet. Now click in any box containing data in the sheet. 
You would have to hold down the Ctrl key while pressing an arrow key, which moves the 
insertion point as described here − 

Key Combination Where the Insertion Point Moves 

Ctrl +  To the last box containing data of the current row. 

Ctrl +  To the first box containing data of the current row. 

Ctrl +  
To the first box containing data of the current column. 
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Ctrl +  
To the last box containing data of the current column. 

Ctrl + PageUp To the sheet in the left of the current sheet. 

Ctrl + PageDown To the sheet in the right of the current sheet. 

Ctrl + Home To the beginning of the sheet. 

Ctrl + End To the end of the sheet. 

Moving with Go To Command 

Press F5 key to use Go To command, which will display a dialogue box where you will find 
various options to reach to a particular box. 

Normally, we use row and column number, for example K5 and finally press Go To button. 

 

 
Saving New Sheet 

Once you are done with typing in your new excel sheet, it is time to save your sheet/workbook 
to avoid losing work you have done on an Excel sheet. Following are the steps to save an 
edited excel sheet − 

Step 1 − Click the File tab and select Save As option. 
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Step 2 − Select a folder where you would like to save the sheet, Enter file name, which you want to give to your 
sheet and Select a Save as type, by default it is .xlsx format. 
 
Saving New Changes 

There may be a situation when you open an existing sheet and edit it partially or completely, or 
even you would like to save the changes in between editing of the sheet. If you want to save 
this sheet with the same name, then you can use either of the following simple options − 

 Just press Ctrl + S keys to save the changes. 

 Optionally, you can click on the floppy icon available at the top left corner and just 
above the File tab. This option will also save the changes. 

 You can also use third method to save the changes, which is the Save option available 
just above the Save As option as shown in the above screen capture. 

If your sheet is new and it was never saved so far, then with either of the three options, word 
would display you a dialogue box to let you select a folder, and enter sheet name as explained 
in case of saving new sheet. 

Creating New Worksheet 

Three new blank sheets always open when you start Microsoft Excel. Below steps explain you 
how to create a new worksheet if you want to start another new worksheet while you are 
working on a worksheet, or you closed an already opened worksheet and want to start a new 
worksheet. 

Step 1 − Right Click the Sheet Name and select Insert option. 

Step 2 − Now you'll see the Insert dialog with select Worksheet option as selected from the general tab. Click 
the Ok button. 

 

File Type File Name 
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You can use a short cut to create a blank sheet anytime. Try using the Shift+F11 keys and you will see a new 
blank sheet similar to the above sheet is opened. 

Inserting Data 
For inserting data in MS Excel, just activate the cell type text or number and press enter or 

Navigation keys. 

 

Inserting Formula 
For inserting formula in MS Excel go to the formula bar, enter the formula and then press enter or 

navigation key. See the screen-shot below to understand it. 

Active cell for Inserting Data 
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Delete with Mouse 

Select the data you want to delete. Right Click on the sheet. Select the delete option, to delete 
the data. 

Delete with Delete Key 

Select the data you want to delete. Press on the Delete Button from the keyboard, it will delete 
the data. 

 

Selective Delete for Rows 

Entering Formula in MS 
Excel 
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Select the rows, which you want to delete with Mouse click + Control Key. Then right click 
to show the various options. Select the Delete option to delete the selected rows. 

 

Find and Replace Dialogue 

Let us see how to access the Find & Replace Dialogue. 

To access the Find & Replace, Choose Home → Find & Select → Find or press Control + F 
Key. See the image below. 

 

 
 
Exploring Options 

Now, let us see the various options available under the Find dialogue. 

 Within − Specifying the search should be in Sheet or workbook. 

 Search By − Specifying the internal search method by rows or by columns. 

Text to Find  New text to replace 
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 Look In − If you want to find text in formula as well, then select this option. 

 Match Case − If you want to match the case like lower case or upper case of words, 
then check this option. 

 Match Entire Cell Content − If you want the exact match of the word with cell, then 
check this option. 

Formatting Cell 

MS Excel Cell can hold different types of data like Numbers, Currency, Dates, etc. You can 
set the cell type in various ways as shown below − 

 Right Click on the cell » Format cells » Number. 

 Click on the Ribbon from the ribbon. 

 
 
Various Cell Formats 

Below are the various cell formats. 

 General − This is the default cell format of Cell. 

 Number − This displays cell as number with separator. 

 Currency − This displays cell as currency i.e. with currency sign. 

 Accounting − Similar to Currency, used for accounting purpose. 

 Date − Various date formats are available under this like 17-09-2013, 17th-Sep-2013, 
etc. 

 Time − Various Time formats are available under this, like 1.30PM, 13.30, etc. 

 Percentage − This displays cell as percentage with decimal places like 50.00%. 

 Fraction − This displays cell as fraction like 1/4, 1/2 etc. 
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 Scientific − This displays cell as exponential like 5.6E+01. 

 Text − These displays cell as normal text. 

 Special − Special formats of cell like Zip code, Phone Number. 

 Custom − You can use custom format by using this. 

Setting Font from Home 

You can set the font of the selected text from Home » Font group » select the font. 

 
 
Text Decoration 

Various options are available in-Home tab of the ribbon as mentioned below. 

 Bold − It makes the text in bold by choosing Home » Font Group » Click B or 
Press Control + B. 

 Italic − It makes the text italic by choosing Home » Font Group » Click I or 
Press Control + I. 

 Underline − It makes the text to be underlined by choosing Home » Font Group » 
Click U or Press Control + U. 

 Double Underline − It makes the text highlighted as double underlined by 
choose Home » Font Group » Click arrow near U » Select Double Underline. 

Rotating Cell from Home Tab 

Click on the orientation in the Home tab. Choose options available like Angle Counter 
Clockwise, Angle Clockwise, etc. 
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Rotating Cell from Formatting Cell 

Right Click on the cell. Choose Format cells » Alignment » Set the degree for rotation. 

 
 
Changing Background Color 

By default, the background colour of the cell is white in MS Excel. You can change it as per 
your need from Home tab » Font group » Background colour. 

Changing Foreground Color 

By default, the foreground or text colour is black in MS Excel. You can change it as per your 
need from Home tab » Font group » Foreground colour. 
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Change Alignment from Home Tab 

You can change the Horizontal and vertical alignment of the cell. By default, Excel aligns 
numbers to the right and text to the left. Click on the available option in the Alignment group 
in Home tab to change alignment. 

 

Change Alignment from Format Cells 

Right click on the cell and choose format cell. In format cells dialogue, choose Alignment 
Tab. Select the available options from the Vertical alignment and Horizontal alignment 
options. 

Alignment Group 
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Exploring Alignment Options 

1. Horizontal Alignment − You can set horizontal alignment to Left, Centre, Right, etc. 

 Left − Aligns the cell contents to the left side of the cell. 

 Center − Centers the cell contents in the cell. 

 Right − Aligns the cell contents to the right side of the cell. 

 Fill − Repeats the contents of the cell until the cell’s width is filled. 

 Justify − Justifies the text to the left and right of the cell. This option is applicable only 
if the cell is formatted as wrapped text and uses more than one line. 

2. Vertical Alignment − You can set Vertical alignment to top, Middle, bottom, etc. 

 Top Aligns the cell contents to the top of the cell. 

 Center Centers the cell contents vertically in the cell. 

 Bottom Aligns the cell contents to the bottom of the cell. 

 Justify Justifies the text vertically in the cell; this option is applicable only if the cell is 
formatted as wrapped text and uses more than one line. 

Merge Cells 

MS Excel enables you to merge two or more cells. When you merge cells, you don’t 
combine the contents of the cells. Rather, you combine a group of cells into a single cell that 
occupies the same space. 

You can merge cells by various ways as mentioned below. 

 Choose Merge & Center control on the Ribbon, which is simpler. To merge cells, 
select the cells that you want to merge and then click the Merge & Center button. 

Horizontal 
Alignment  

Vertical Alignment  



Computer Applications in Economics  

Dr. P. Sujatha, Assistant Professor in Economics, ADM College for Women (Autonomous)     Page 62  

 
 
Additional Options 

The Home » Alignment group » Merge & Center control contains a drop-down list with 
these additional options − 

 Merge Across − When a multi-row range is selected, this command creates multiple 
merged cells — one for each row. 

 Merge Cells − Merges the selected cells without applying the Center attribute. 

 Unmerge Cells − Unmerges the selected cells. 

Wrap Text and Shrink to Fit 

If the text is too wide to fit the column width but don’t want that text to spill over into adjacent 
cells, you can use either the Wrap Text option or the Shrink to Fit option to accommodate that 
text. 

 

 
Apply Borders 
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MS Excel enables you to apply borders to the cells. For applying border, select the range of 
cells Right Click » Format cells » Border Tab » Select the Border Style. 

 

 

 
Then you can apply border by Home Tab » Font group » Apply Borders. 

 
 
Apply Shading 

You can add shading to the cell from the Home tab » Font Group » Select the Colour. 
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Margins 

Margins are the unprinted areas along the sides, top, and bottom of a printed page. All printed 
pages in MS Excel have the same margins. You can’t specify different margins for different 
pages. 

You can set margins by various ways as explained below. 

 Choose Page Layout » Page Setup » Margins drop-down list, you can select Normal, 
Wide, Narrow, or the custom Setting. 

 
Formulas in MS Excel 

Formulas are the Bread and butter of worksheet. Without formula, worksheet will be 
just simple tabular representation of data. A formula consists of special code, which is entered 
into a cell. It performs some calculations and returns a result, which is displayed in the cell. 

Formulas use a variety of operators and worksheet functions to work with values and 
text. The values and text used in formulas can be located in other cells, which makes changing 
data easy and gives worksheets their dynamic nature. For example, you can quickly change the 
data in a worksheet and formulas works. 

Elements of Formulas 
A formula can consist of any of these elements 

 Mathematical operators, such as + (for addition) and *(for multiplication) 

Example   

=A1+A2 Adds the values in cells A1 and A2. 

 Values or text 

Example  

= 200*0.5 Multiplies 200 times 0.15. This formula uses only values, and it always 
returns the same result as 100. 
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 Cell references (including named cells and ranges) 

Example  

= A1=C12 Compares cell A1 with cell C12. If the cells are identical, the formula 
returns TRUE; otherwise, it returns FALSE. 

 Worksheet functions (such as SUM or AVERAGE) 

Example  

= SUM (A1:A12) Adds the values in the range A1:A12. 

Creating Formula 

For creating a formula, you need to type in the Formula Bar. Formula begins with '=' 
sign. When building formulas manually, you can either type in the cell addresses or you can 
point to them in the worksheet. Using the Pointing method to supply the cell addresses for 
formulas is often easier and more powerful method of formula building. When you are using 
built-in functions, you click the cell or drag through the cell range that you want to use when 
defining the function’s arguments in the Function Arguments dialog box. See the below screen 
shot. 

 

 

As soon as you complete a formula entry, Excel calculates the result, which is 

then displayed inside the cell within the worksheet (the contents of the formula, 

however, continue to be visible on the Formula bar anytime the cell is active). If you 

make an error in the formula that prevents Excel from being able to calculate the 

formula at all, Excel displays an Alert dialog box suggesting how to fix the problem. 

 

Formula Bar to Write Formula 

Result cell Where formula is written 
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Built in Functions 

MS Excel has many built in functions, which we can use in our formula. To see 

all the functions by category, choose Formulas Tab » Insert Function. Then Insert 

function Dialog appears from which we can choose the function. 

 

Functions by Categories 

Let us see some of the built-in functions in MS Excel. 

 Text Functions 

o LOWER − Converts all characters in a supplied text string to lower case 

o UPPER − Converts all characters in a supplied text string to upper case 

o TRIM − Removes duplicate spaces, and spaces at the start and end of a text 
string 

o CONCATENATE − Joins together two or more text strings. 

o LEFT − Returns a specified number of characters from the start of a supplied 
text string. 

o MID − Returns a specified number of characters from the middle of a supplied 
text string 

o RIGHT − Returns a specified number of characters from the end of a supplied 
text string. 

o LEN − Returns the length of a supplied text string 

o FIND − Returns the position of a supplied character or text string from within a 
supplied text string (case-sensitive). 
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 Date & Time 

o DATE − Returns a date, from a user-supplied year, month and day. 

o TIME − Returns a time, from a user-supplied hour, minute and second. 

o DATEVALUE − Converts a text string showing a date, to an integer that 
represents the date in Excel's date-time code. 

o TIMEVALUE − Converts a text string showing a time, to a decimal that 
represents the time in Excel. 

o NOW − Returns the current date & time. 

o TODAY − Returns today's date. 

 Statistical 

o MAX − Returns the largest value from a list of supplied numbers. 

o MIN − Returns the smallest value from a list of supplied numbers. 

o AVERAGE − Returns the Average of a list of supplied numbers. 

o COUNT − Returns the number of numerical values in a supplied set of cells or 
values. 

o COUNTIF − Returns the number of cells (of a supplied range), that satisfies a 
given criteria. 

o SUM − Returns the sum of a supplied list of numbers 

 Logical 

o AND − Tests a number of user-defined conditions and returns TRUE if ALL of 
the conditions evaluate to TRUE, or FALSE otherwise 

o OR − Tests a number of user-defined conditions and returns TRUE if ANY of 
the conditions evaluate to TRUE, or FALSE otherwise. 

o NOT − Returns a logical value that is the opposite of a user supplied logical 
value or expression i.e. returns FALSE if the supplied argument is TRUE and 
returns TRUE if the supplied argument is FAL 

 Math & Trig 

o ABS − Returns the absolute value (i.e. the modulus) of a supplied number. 

o SIGN − Returns the sign (+1, -1 or 0) of a supplied number. 

o SQRT − Returns the positive square root of a given number. 

o MOD − Returns the remainder from a division between two supplied numbers. 

Charts 

A chart is a visual representation of numeric values. Charts (also known as graphs) have 
been an integral part of spreadsheets. Charts generated by early spreadsheet products were 
quite crude, but they have improved significantly over the years. Excel provides you with the 
tools to create a wide variety of highly customizable charts. Displaying data in a well-
conceived chart can make your numbers more understandable. Because a chart presents a 
picture, charts are particularly useful for summarizing a series of numbers and their 
interrelationships. 
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Types of Charts 

There are various chart types available in MS Excel as shown in the below screen-shot. 

 

 
 

 Column − Column chart shows data changes over a period of time or illustrates 
comparisons among items. 

 Bar − A bar chart illustrates comparisons among individual items. 

 Pie − A pie chart shows the size of items that make up a data series, proportional to the 
sum of the items. It always shows only one data series and is useful when you want to 
emphasize a significant element in the data. 

 Line − A line chart shows trends in data at equal intervals. 

 Area − An area chart emphasizes the magnitude of change over time. 

 X Y Scatter − An xy (scatter) chart shows the relationships among the numeric values 
in several data series, or plots two groups of numbers as one series of xy coordinates. 

 Stock − This chart type is most often used for stock price data, but can also be used for 
scientific data (for example, to indicate temperature changes). 

 Surface − A surface chart is useful when you want to find the optimum combinations 
between two sets of data. As in a topographic map, colors and patterns indicate areas 
that are in the same range of values. 

 Doughnut − Like a pie chart, a doughnut chart shows the relationship of parts to a 
whole; however, it can contain more than one data series. 

 Bubble − Data that is arranged in columns on a worksheet, so that x values are listed in 
the first column and corresponding y values and bubble size values are listed in 
adjacent columns, can be plotted in a bubble chart. 

 Radar − A radar chart compares the aggregate values of a number of data series. 

Available 
Charts 
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Creating Chart 

To create charts for the data by below mentioned steps. 

 Select the data for which you want to create the chart. 

 Choose Insert Tab » Select the chart or click on the Chart group to see various chart 
types. 

 Select the chart of your choice and click OK to generate the chart. 

 

 

 

Data for Chart 

Inserted Chart 
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Editing Chart 

You can edit the chart at any time after you have created it. 

 You can select the different data for chart input with Right click on chart » Select 
data. Selecting new data will generate the chart as per the new data, as shown in the 
below screen-shot. 

 You can change the X axis of the chart by giving different inputs to X-axis of chart. 

 You can change the Y axis of chart by giving different inputs to Y-axis of chart. 
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How to  create E-Mail 
 

1. Open the Gmail account website.  
Go to https://www.google.com/gmail/about/# in your computer's web browser.  
This will open a page with information regarding Gmail. 
 

 
 

2. Clicks “CREATE AN ACCOUNT” button. 

 It's a red button in the top-right corner of the window. Doing so takes you to the first page 
in the account creation section. 

3. Enter your first and last name.  
Type your first name into the "First name" text box near the top of the page, and then enter 

your last name in the "Last name" box next to it. 
 

 
 

4. Create a Gmail username.  
In the "Username" text box, type in the username you want to use for your email address. 

This is the name which appears before the "@gmail.com" section of the address. 
 If your entered username already exists, you'll be asked to choose a different one 
upon clicking a different text box on the page. 
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5. Enter a password twice.  
Type your preferred password into the "Password" text box near the bottom of the page and 

then type the same password into the "Confirm password" box to the right of the first 
password box. 

 
These passwords must match before you can proceed. 
 
Click “NEXT” button. It's a blue button at the bottom of the page. 

 

 
6. Enter account recovery options.  
While not mandatory, you can add up to two types of account recovery options to your 

Gmail profile: 
 Phone number: Type your phone number into the "Phone number" text box near 

the top of the page. 
 Recovery email address: Type any other email address into the "Recovery email 

address" text box near the top of the page. 
 

7. Add your date of birth.  
Click the "Month" drop-down box and select the month of your birthday, then type the 

day and year into the "Day" and "Year" text boxes, respectively. 
 

8. Select a gender.  
Click the "Gender" drop-down box, and then select one of the gender options in the 

resulting drop-down menu. 
 

9. Click NEXT button : It's a blue button at the bottom of the page. 
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10. Verify your phone number.  
If you added a phone number as an account recovery option, you can verify it now by 

doing the following: 
 

 Click SEND when prompted. 
 Open your phone's text messages. 
 Open the message from Google (usually a 5-digit number) and review the 6-digit 

number in the message. 
 Enter the 6-digit number into the text box on the Gmail page. 
 Click VERIFY 
 You can also click the Not now link to skip verifying the account recovery 

options for now. 
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11. Scroll down and click I AGREE.  
It's at the bottom of the terms of service list on the left side of the page. Doing so will 

accept the terms of service and sign you into your Gmail account. 
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MS - PowerPoint 

 PowerPoint is the presentation software of the Microsoft Office software suite. One of 

the most widely used office programs; PowerPoint has applications for personal use, academics 

and business.  

 It is highly customizable; you can edit PowerPoint presentations to be as personal or 

professional as you want. PowerPoint has a relatively simple user interface which you can 

easily pick up. However, mastering each of its functions will allow you to create impressive 

presentations to engage your audience. 

 

Design 

 The design features of PowerPoint allow you to customize the appearance and format of 

the slides. PowerPoint typically comes with a set of preloaded themes for you to choose from. 

These can range from simple color changes to complete format layouts with accompanying font 

text. Themes can be applied through the whole presentation or a single slide. Using the page 

setup allows you to optimize the presentation for the display size; for instance, you should use a 

larger screen ratio when displaying on a projector compared to a computer screen. 

 

Animation 

 PowerPoint animation is divided between slide transitions and element animation. Using 

slide transition adds an effect when switching slides during a slide show. You can edit the 

transition effect and timing, as well as opt for an on-click or automatic transition between 

slides. Element animation adds movement and sounds to the objects within the slide. For 

example, if you're constructing a photo gallery as a slide show, you can choose which pictures 

enter the slide first, how they enter and add a sound as they enter. 

 

Presentation 

 The presentation function of PowerPoint is largely designed to accommodate public 

speaking. PowerPoint comes with a built-in notes function; when printing out presentation 

slides, you can add presenter notes beside each slide as accompanying content. This is useful to 

clarify points in the slide without sacrificing the slide's readability. PowerPoint also has a 

rehearsal function as well, allowing you or your team to practice your timing and monitor the 

length of your presentation. 
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Integration 

 PowerPoint is compatible with all other software in the Microsoft Office suite; you can 

export slides into Word documents or use Excel charts within your presentation. In addition to 

image and audio support, you can embed videos within a presentation for easy playback without 

exiting the program. You can also export presentation files to an online interface for multi-user 

remote editing and presentation practice. 

Step 1: Click the Start button. 

Step 2: Click All Programs option from the menu. 

Step 3: Search for Microsoft Office from the sub menu and click it. 

Step 4: Search for Microsoft PowerPoint from the submenu and click it. 

 

 

 

This will launch the Microsoft PowerPoint 2010 application and you will see the following 
presentation window. 

 

 

 

 

Title Bar 

Slide View Zoom views Slide Area 
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File Tab  

This tab opens the Backstage view which basically allows you to manage the 
file and settings in PowerPoint. You can save presentations, open existing ones and 
create new presentations based on blank or predefined templates. The other file related 
operations can also be executed from this view. 

Title Bar  

This is the top section of the window. It shows the name of the file followed by 
the name of the program which in this case is Microsoft PowerPoint. 

 Slide Area  

This is the area where the actual slide is created and edited. You can add, edit 
and delete text, images, shapes and multimedia in this section. 

Zoom Options  

The zoom control lets you zoom in for a closer look at your text. The zoom 
control consists of a slider that you can slide left or right to zoom in or out, you can 
click on the - and + buttons to increase or decrease the zoom factor. The maximum 
zoom supported by PowerPoint is 400% and the 100% is indicated by the mark in the 
middle. 

Slide Views  

The group of four buttons located to the left of the Zoom control, near the 
bottom of the screen, lets you switch between PowerPoint views.   

Normal Layout view: This displays page in normal view with the slide on the 
right and a list of thumbnails to the left. This view allows you to edit individual slides 
and also rearrange them.   

Slide Sorter view: This displays all the slides as a matrix. This view only 
allows you to rearrange the slides but not edit the contents of each slide.  

 Reading View: This view is like a slideshow with access to the Windows task 
bar in case you need to switch windows. However, like the slideshow you cannot edit 
anything in this view. 

Slide Tab  

This section is available only in the Normal view. It displays all the slides in 
sequence. You can add, delete and reorder slides from this section. 

PowerPoint offers a host of tools that will aid you in creating a presentation. 
These tools are organized logically into various ribbons in PowerPoint. The table below 
describes the various commands you can access from the different menus. 

we will understand how to add new slides in an existing presentation.  
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Step 1: Right-click in the Navigation Pane under any existing slide and click on the 
New Slide option 

Step 2: The new slide is inserted. You can now change the layout of this slide to suit 
your design requirements. 

Step 3: To change the slide layout, right-click on the newly inserted slide and go to 
the Layout option where you can choose from the existing layout styles available to 
you. 

 

Title Box  

  This is typically found on slides with the title layout and in all the slides that 
  have a title box in them. This box is indicated by "Click to add title". 

Subtitle Box  

  This is found only in slides with the Title layout. This is indicated by "Click to 
add subtitle".  

Content Box  

This is found in most of the slides that have a placeholder for adding content. 
This is indicated by "Click to add text". As you can see, this box allows you to add text 
as well as non-text content. To add text to such a box, click anywhere on the box, 
except on one of the content icons in the centre and start typing. 

Text Only Box  

This is not a default content box available in PowerPoint, but you can create it 
using Slide Master, if required. This is also indicated by "Click to add text". The only 
difference between the Text Only Box and the Content Box is that the former only 
supports text in the content area. 

There are times while building a slide deck, you may need to delete some slides. 
This can be done easily from PowerPoint. You can delete the slides from the Normal 
view as well as the Slide Sorter view. In each view, you can delete the slides in two 
ways.  

Title Box 

Sub Title Box 

Insert Slide  


